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Purpose 

The entire purpose of entering data into Roofing Passport is for the outputs the application produces. 
Sales Quotes, Material Lists, Layout and Panel Drawings — a once Roofing Passport is properly set up 
your organization will be producing these and other outputs in record time with incredible accuracy and 
efficiency. The purpose of this document is to teach you, as a new Roofing Passport System 
Administrator, how to setup, customize, and maintain outputs that fulfill the specific needs of your 
organization. 

Types of Outputs 

Right out of the box, Roofing Passport provides eight (8) different types of outputs. As the Systems 
Administrator, you will choose: 

 The specific outputs that are to be made available to your users 

 The job phase(s) during which each output is made available 

 The customization options for your outputs 

The eight different types of Roofing Passport outputs break down into two separate categories – 
Essential Outputs and Application-Specific Outputs. Following is a brief description of each output by 
type. 

NOTE – An example of each different type of Roofing Passport output is provided in the appendices 
of this document. 

ESSENTIAL OUTPUTS 

Essential outputs include all of the drawings and documentation needed to successfully bid and 
construct a new roof. They include the following: 

1. Sales Quote – This is the customized Sales Quote document to be presented to each of your 
customers when bidding a job. The Sales Quote output can be as simple or as sophisticated as 
you like. Since the Sales Quote will be the first document presented to potential customers, it is 
worthwhile to invest time in making this output as professional in content and appearance as 
possible. This output is provided in Microsoft Word format. (See the example provided in 
Appendix A.) 

2. Job Data (Comprehensive) – The Comprehensive Job Data output provides a complete Materials 
List for a job, along with a summary of the job’s administrative and pricing information. This 
document is commonly used by a project manager to make sure all required materials are 
present and cost and pricing information are correct for every line item. The Comprehensive Job 
Data output is provided in Microsoft Excel format, and neither its contents nor format can be 
customized. (See the example provided in Appendix B.) 

3. Job Data (Custom) – Like the Comprehensive Job Data output, the contents of the Custom Job 
Data output can include both materials and administrative information about a job. Often used 
as a customized order list for procurement, the contents of this output are highly customizable 
and the output is available in both PDF and CSV format. (See the examples provided in Appendix 
C and Appendix D) 
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4. Roof Layout Drawings – This output shows the layout of an entire roof, plane by plane. The 
Systems Administrator can elect to include or exclude the display of all individual sheathing 
panels in this drawing. You might elect to create two outputs, one with the individual panels and 
one without. This output is provided in PDF format. (See the example provided in Appendix D.) 

5. Sheathing Drawings – This output provides a separate diagram for each individual roof plane, 
showing the layout of the sheathing panels in high detail. This output is provided in PDF format. 
(See the example provided in Appendix E.) 

6. Job Summary Sheet – A single page that includes a 2D representation of your 3D Roofing 
Passport model, along with the basic address and contact information for a project entered into 
the Roofing Passport Jobs Tab. This output is frequently used as a cover sheet for the Roof 
Layout and Sheathing Drawings used in the field. This output is provided in PDF format. (See the 
example provided in Appendix F.) 

APPLICATION-SPECIFIC OUTPUTS 

Used by only some of our customers, Roofing Passport includes two outputs that are designed to 
interface with other applications: 

1. Sketchup SKP File – This output creates a copy of your 3D model that can be opened and edited 
using SketchUp’s design and output tools. 

2. Json File – The Json File is an extremely advanced output that is used exclusively by developers 
to implement an Application Programming Interface (API) between Roofing Passport and 
another application, such as a materials inventory management system. For more information 
about the Json File output and its use, please contact the Keymark Support Team at 
mailto:support@keymark.com. 

  

mailto:support@keymark.com
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Parts of the Outputs Window 

Setting up and customizing the Roofing Passport outputs for your organization is accomplished using the 
Outputs page for System Administrators. To access this page, go to the Menu Bar and click on Settings 
 Outputs. This will open an Outputs window like the one pictured in Figure 1 below. Please take a 
moment to review the various parts of the Outputs window, as described in this section. 

1. MENU BAR 

The Menu Bar is common to most areas within the Roofing Passport interface. The functions related to 
the Menu Bar are outlined in multiple Roofing Passport help documents, so we will not repeat them 
here. (See the Roofing Passport Quick Start User’s Guide for additional information) 

2. OUTPUTS TOOLBAR 

The Outputs Toolbar contains command buttons for executing the most common functions on the 
Roofing Passport Outputs page. Following is a list of these commands and the purpose of each: 

Add – Click the Add button to create a new output for your organization. Clicking on this button will 
open a dialog box that allows you to choose the type of output you wish to create, along with any 
output-specific parameters that need to be defined. 

Edit – This will display a dialog box allowing you to make changes to the parameters for the selected 
output. 

Delete – Removes selected output from the system. 

Move Top – Clicking on this button will move the selected Output to the very top of your Outputs 
List. 

Move Up – Clicking on this button will move the selected Output up one spot in your Outputs List.  

Figure 1: Parts of the Roofing Passport Outputs window used by System Administrators. 

https://postframesolver.blob.core.windows.net/test-help-files/PDF-RP/RP-QSUG.pdf
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Move Down – Clicking on this button will move the selected Output down one spot in your Outputs 
List. 

Move Bottom – Clicking on this button will move the selected Output to the very bottom of your 
Outputs List. 

Cancel – Clicking on the Cancel button will return you to your Jobs List page without saving any 
changes you have made to the configuration of your Outputs. 

Save – Click on the Save button to retain all changes made to the configuration of your Outputs 
since the last Save operation. If you attempt to leave the Outputs page without saving your 
changes, a dialog box will open asking if you wish to Save your changes before leaving. 

3. OUTPUTS LIST 

This section of the Outputs window displays all of the outputs that are currently available to your users. 
As you can see in Figure 1 (previous page), the Outputs List contains eight (8) columns of information 
that are used to describe and configure each Output. Here is a brief description of the purpose and 
function of each of these columns:  

Group – The Group column is used to indicate whether or not a given output is produced in PDF 
format. All PDF-based outputs are grouped together at the top of the System Administrator’s 
Outputs page. 

Default – Activating this Default checkbox automatically includes the selected output for users 
when they click on the Outputs button for a job. 

Hide New – Activating the Hide New checkbox will hide the selected Output from users when the 
current status for job is listed as “New” in a Roofing Passport. 

Hide Quoted – Activating the Hide Quoted checkbox will hide the selected Output from users when 
the current status for a Roofing Passport job is listed as “Quoted.” 

Hide Ordered – Activating the Hide Ordered checkbox will hide the selected Output from users 
when the current status for a Roofing Passport job is listed as “Ordered.” 

Description – This field is used to provide a Name and Description for each output that can easily 
be recognized by users. This field is automatically populated by Roofing Passport within the Create 
Output dialog box, however, System Administrators have the ability to enter any descriptive 
information they wish. 

Auto Quote – Activating the Auto Quote checkbox causes the selected Output to be generated 
automatically whenever a job’s status is changed to “Quoted.” 

Auto Order – Activating the Auto Order checkbox causes the selected Output to be generated 
automatically whenever a job’s status is changed to “Ordered.” 

NOTE – The Outputs List in Figure 1 (previous page) shows the four outputs that Roofing Passport 
includes in your list be default. These four outputs can be deleted or modified by the Systems 
Administrator in any way he/she deems appropriate. 
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Figure 2: The Add Report [output] dialog box. 

Figure 3: The dialog used to Download and Upload 
a Sales Quote template into and out of Roofing 
Passport. 

Creating New Outputs 

To create a new output, on the Outputs page (Figure 1, 
page 1) go to the Outputs Toolbar and click on the Add 
button. This will open the Add Report dialog box pictured at 
right in Figure 2. Using the Type drop-down list in this 
dialog box, select the type of output you wish to create. The 
contents displayed in lower portion of this dialog box will 
then change, depending on the type of output you have 
selected. We will outline the required procedures for each 
different type of output in the pages that follow. 

NOTE – Once you have selected an Output Type from 
the drop-down list, Roofing Passport will automatically 
populate the Description field above it with the 
name of the item selected. If you later change the Type 
of output selected from the drop-down list, Roofing 
Passport WILL NOT automatically change the 
Description field. 

Creating Essential Outputs 

The following section provides instructions for creating  
each of the different Essential Outputs available in Roofing  
Passport. 

DOCUMENT [SALES QUOTE] TEMPLATE 

Every job begins by providing a potential customer with a 
formal, written Sales Quote. (See Appendix A of this 
document for a sample completed Sales Quote 
document.) The process of creating Sales Quotes begins 
by creating a template that Roofing Passport will use to 
generate these documents. The template you create will 
be a Microsoft Word document that contains a 
combination of the standard text your company uses for 
quotes, along with a series of “tokens” that Roofing 
Passport will use to fill in all of the job-specific 
information needed for the quote (materials, 
dimensions, prices, and so on). 

To create a new Sales Quote output, refer to the Add 
Report dialog box shown in Figure 3 (right). Within this 
dialog box, where it says “Click here to download a 
sample .docx file…” go ahead and click on the word 
“here.” This will download a Word file (Document 
Template.docx) that contains all of the tokens needed 
to generate job-specific information “on the fly” for your  
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Sales Quotes. (For additional information, please see Creating Your Sales Quotes Template.) 

COMPREHENSIVE JOB DATA (EXCEL WORKBOOK) 

The Excel Workbook (a.k.a. the Comprehensive Job Data 
output) provides documentation of ALL job-related data 
for a project. (See Appendix B of this document for a 
sample Excel Workbook.)  

As you can see in Figure 4 at right, the Supplier ID 
field is the only customization option available for this 
output. If you wish to restrict this particular output to 
include only those materials provided by a specific 
Supplier, you can enter that Supplier’s ID in the field 
provided here. 

Once you have entered the required information, click 
on the Save button to close the dialog box and save the 
new output. 

 

  

Figure 4: The Add Report dialog box used to create a 
new Excel Workbook output. 
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CUSTOM JOB DATA (PDF) 

As the name implies, the Custom Job Data output is a highly customizable report that can be configured 
to meet the specific needs of your organization. This output is available in two formats; PDF (described 
here), and CSV (described in the section immediately following). Your Job Data output can include any or 
all of the information listed below: 

1. Include Job Info [Checkbox] – When this 
checkbox is enabled, some or all information 
listed on the Job Tab will be included in the 
output (building address, contacts, etc.). The 
specific information to be included is defined in 
the Job Infos field immediately below it. 

2. Job Infos [Field] – When the Include Job Info 
checkbox has been enabled, the Job Infos field 
is used to limit the Job Data included in the 
output to the specific data elements defined by 
you, the Systems Administrator. If you leave this 
field blank, ALL job fields displayed on the Jobs 
Tab of the Property Pane will be included in the 
output. For information on how to fill out the 
Job Infos field, please see Populating the Jobs 
Info Field on page 12. 

3. Include Materials [Checkbox] – When this 
checkbox is enabled, this Job Data output will 
include a summary of the job’s required 
materials. (See Appendix C on page 20 for an 
example Job Data output that includes 
materials.) 

4. Ignore Usage [Checkbox] – When this checkbox is enabled, this output will consolidate entries 
under each type of material (Sheathing, Trim, Accessories, etc.) regardless of the 
materials’ usage. For example, when the same material is used for both gable trim and eave 
trim, these materials will be combined as a single line item on the output. 

5. Omit Category Groups [Checkbox] – When this checkbox is enabled, Roofing Passport combines 
all required materials into a single list, without a header row separating each material by type. 

6. Group Addons [Checkbox] – When this checkbox is enabled, Roofing Passport will list all Add-
ons with their associated component (Door, Window, or Cupola, etc.). 

7. Columns [Field] – The Columns field is used to define the specific columns of data in the 
Materials Database that are to be included in an output. If you leave this field blank, ALL 
columns of materials data will be included. If you wish to restrict the materials data to specific 
columns, you will need to enter the name of each column PRECISELY as it appears in the 
Materials Database AND in the specific format required by Roofing Passport. For additional 
information, please see the nearly identical process outlined under Populating the Job Infos 
Field on page 12. 

Figure 5: The Add Report dialog as it appears when 
creating a new Job Data PDF output. 



 

10 
 

8. Pitch Totals [Checkbox] – When this checkbox is enabled, the output will include a calculation 
for the square feet of each roof pitch (plane), as well as the total combined square feet for the 
entire job. 

9. Skip Material Errors [Checkbox] – When this checkbox is enabled, this output will omit all 
materials with recognized pricing errors. 

10. Supplier Id [Field] – If you are including materials information in your Job Data output, and you 
wish to limit the materials included to one or more specific Suppliers, you must enter the target 
Supplier ID(s) into this field. When adding multiple Supplier IDs, separate each with a 
comma. 

CUSTOM JOB DATA (CSV) 

The Custom Job Data output is available in two formats; CSV (Comma Separated Values) which is 
described here, and PDF, which is described in on the previous page. This output is highly customizable 
and can include any or all of the information listed below: 

1. Include Job Info [Checkbox] – When this 
checkbox is enabled, some or all of the 
information listed on the Job Tab will be 
included in the output (building address, 
contacts, etc.). The specific information to be 
included is defined in the Job Infos field 
immediately below it. 

2. Job Infos [Field] – Once the Include Job Info 
checkbox has been enabled, the Job Infos field 
is used to limit the job data to be included in the 
output to the specific data elements defined by 
you, the Systems Administrator. If you leave this 
field blank, ALL job fields displayed on the Jobs 
Tab of the Property Pane will be included in the 
output. For information on how to fill out the 
Job Infos field, please see Populating the Jobs 
Info Field on page 12. 

3. Include Materials [Checkbox] – When this 
checkbox is enabled, the Job Data output will 
include a summary of the job’s required 
materials. (See Appendix D on page 21 for an 
example Job Data output that includes 
materials.) 

4. Ignore Usage [Checkbox] – When this checkbox is enabled, this output will consolidate entries 
under each type of material (Sheathing, Trim, Accessories, etc.) regardless of the 
material’s usage. For example, when the same material is used for both gable trim and eave 
trim, these materials will be combined as a single line item on the output. 

5. Omit Category Groups [Checkbox] – When this checkbox is enabled, Roofing Passport combines 
all required materials into a single list, without a header row separating each materials group by 
type. 

Figure 6: The Add Report dialog as it appears when 
creating a new Job Data CSV output. 
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6. Group Addons [Checkbox] – When this checkbox is enabled, Roofing Passport will list all Add-
ons with their associated component (Door, Window, or Cupola, etc.). 

7. Omit Header Row [Checkbox] – When this checkbox is enabled, your Jobs Data CSV output WILL 
NOT include any of the header rows used to identify the contents of each column of data. This 
feature is made available for organizations that Upload Roofing Passport data into other 
applications they use in house. 

8. Columns [Field] – The Columns field is used to define the specific columns of data in the 
Materials Database that are to be included in an output. If you leave this field blank, ALL 
columns of materials data will be included. If you wish to restrict the materials data to specific 
columns, you will need to enter the name of each column PRECISELY as it appears in the 
Materials Database AND in the specific format required by Roofing Passport. For additional 
information, please see the nearly identical process documented under Populating the Job Infos 
Field on page 12. 

9. Pitch Totals [Checkbox] – When this checkbox is enabled, the output will include a calculation 
for the square feet of each roof pitch (plane), as well as the total combined square feet for the 
entire job. 

10. Skip Material Errors [Checkbox] – When this checkbox is enabled, the output will omit all 
materials with recognized pricing errors. 

11. Supplier Id [Field] – If you are including materials information in your Job Data output, and you 
wish to limit the materials included to one or more specific Suppliers, you must enter the target 
Supplier ID(s) into this field. When adding multiple Supplier IDs, separate each with a 
comma.  
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Populating the Job Infos Field 

As you know by now, every organization creates its own 
customized collection of Job Data that is used to provide 
the administrative information required to manage each 
job. (This is the collection of data displayed on the Job 
Tab in the Properties Pane of Roofing Passport, as 
shown in Figure 7 at right.) Our objective here is to: 

1. Identify the Job Data you wish to include in a 
new Custom Job Data output (PDF or CSV) and 
then,  

2. Enter the name of each data element to be 
included into the Job Infos field of the Add 
Report dialog box. (See Figure 8.) 

The trick is that the name of each of these data 
elements must be entered into the Job Infos field 
PRECISELY as it entered into your Roofing Passport 
database AND in the PRECISE FORMAT outlined below. 

 

 

 

 

 

PREPARING THE LIST OF DATA ELEMENTS 

Since Job Data is different for every company, we will 
use the Job Data shown in Figure 7 as our example for 
the step-by-step instructions presented below: 

1. Create and save a Job Data output that includes 
ALL Job Information. (That is to say, enable the 
Include Job Info checkbox (Figure 8) and DO NOT 
enter any information into the Job Infos field in the 
Add Report dialog box. The rest of the configuration for 
this output does not matter. Simply accept the defaults 
and click the Save button.) 

2. With your new Job Data CSV output containing  
 ALL Job information now created, go to your Jobs page  
  within Roofing Passport, select any job at random and  

   Download the newly created Job Data CSV output by      
    clicking on the Download button for that job. 

  

Figure 7: Job Data is displayed on the Job Tab of the 
Properties Pane. This set of data is customized to meet 
the needs of each individual company. 

Figure 8: Creating a Job Data output with a limited 
subset of Job Data. 
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3. Open the newly downloaded Job Data CSV file and, from the very top row, copy and paste the 
names of ALL the Job Data columns into a text file, as pictured in the example below. (Microsoft 
WordPad and Microsoft Notepad work equally well for creating this temporary text file.) 

4. Save your new text file with a name like Job Data Columns. This is a temporary file, and you can 
delete it once your new output has been created. 

5. In your newly created text file, delete the names of the columns of Job Data that you DO NOT 
wish to include in your Custom Job Data output. As you can see in the example below, we have 
deleted all of the data elements related to Billing and the Salesperson. 

6. With your list of Job Data column names now paired down to those you wish to include in your 
output, separate the name of each data element from the next with a comma, as shown in the 
figure below. 

7. Last but not least, delete the extra spaces between the commas separating column names as 
shown below. BE SURE TO LEAVE ANY EXISTING SPACES WITHIN THE NAME OF EACH 
INDIVIDUAL DATA ELEMENT, since deleting these spaces will cause your new output to fail. 

8. Save the changes to your text file. 
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ENTERING DATA INTO THE JOB INFOS FIELD 

Now that our list of data elements to be included has been prepared, it is time to enter this information 
into the Job Infos field of the Add Report dialog box. Please perform the following steps: 

1. Go to the File Menu and select Settings  Outputs to open the Administrator’s Outputs 
page. 

2. Click on the Add button to open the Add Report dialog box. 

3. From the Type drop-down list, select the desired output (Job Data PDF or Job Data CSV). 

4. Click in the Include Job Info checkbox to enable it. 

5. Next, open the text file you created in the preceding section (Job Data Columns.txt, or 
whatever you named your file.) Using your mouse or keyboard, select ALL of the text within this 
file and press CTRL-C on your keyboard to Copy the selected data to your computer’s 
clipboard. 

6. Now, go back to your Roofing Passport window and Paste the copied data directly into the Job 
Infos field on the Add Report dialog box. 

7. Make any other desired changes to the configuration of this output and click on the Save 
button to finish the job. 

That does it! Now, when a user generates the Custom Job Data output you just created, it will only 
include those Job Data elements that you have prescribed. 

  



 

15 
 

ROOF LAYOUT DRAWING 

The Roof Layout output is a single-page report that 
provides an aerial view of ALL of the planes (sections) 
that comprise an entire roof. There are only two 
customizations that can be applied to this output: 

Output Type – Use the drop-down list provided to 
select whether this output is to be produced in PDF 
or DXF (AutoCAD) file format. 

Show Sheathing Parts – When this checkbox is 
enabled, this output will include the layout of ALL 
sheathing parts for an entire roof. 

Please see Appendix E on page 22 for an example Roof 
Layout Drawing. 

 

 

 

  

SHEATHING DRAWINGS 

The Sheathing Drawings output is a multi-page report 
that provides a one-page drawing for each section of a 
roof, and the layout of sheathing panels on that section. 
Use the drop-down arrow provided to select whether 
the output is to be produced in PDF or DXF (AutoCAD) 
file format. 

Please see Appendix F on page 23 for an example 
Sheathing Drawing. 

 

 

  

Figure 9: The Add Report dialog as it appears when 
creating a new Roof Layout output. 

Figure 10: The Add Report dialog box for creating a 
new Sheathing Drawings output. 
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SUMMARY SHEET 

The Summary Sheet is a single page report, provided in 
PDF format, that contains the following information: 

Drawing – A 2D representation of a roof’s 3D model 

Summary – The overall dimensions of the target roof. 

Job Information – The Job Information section of 
this output lists the Job Information entered by the 
users into the Jobs Tab of the Property Pane for the 
given project. Even though the Summary Sheet itself 
cannot be customized, the data collected and listed on 
the Jobs Tab is completely customizable, so the 
contents of this section of the report will vary by 
organization. 

Please see Appendix G on page 24 for an example 
Summary Sheet. 

  

Figure 11: The Add Report dialog box for creating a 
new Summary Sheet output. 
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Creating Application-Specific Outputs 

SKETCHUP .SKP FILE 

Roofing Passport is designed to integrate with Trimble 
SketchUp software for companies that have traditionally 
used this application for some or all of their designs 
processes. Now, users can take advantage of Roofing 
Passport’s automated modeling capabilities, and then 
further refine their designs and outputs using SketchUp. 

By creating a SketchUp output, users will be able to 
download a copy of their Roofing Passport 3D model – 
and all its associated data – in a file format that can be 
opened and edited in SketchUp. 

To create a SketchUp output, simply select SketchUp 
.SKP from the Type drop-down list, and enter the 
desired name for this output in the Description field. 
Click on the Save button when you are done, to save the 
output and close the Add Report dialog box. 

 

 

 

JSON FILE 

This output is used to store simple data structures and 
objects in JavaScript Object Notation (JSON); a standard 
data interchange format. It is primarily used for 
transmitting data between a web application and a 
server. 

 

 

 

 

 

 

  

Figure 12: The Add Report dialog box for creating a 
new SketchUp File output. 

Figure 13: The Add Report dialog box for creating a 
new JSON File output. 
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Appendix A: Sales Quote 

Perhaps more than any other Roofing Passport output, the contents and design of the Sales Quote varies 
greatly by organization. Using the tokens provided in the Add Report dialog box (see page 7 ) Systems 
Administrators can create one or more Sales Quote templates that provide the specific information 
needed by their organizations. Since the Sales Quote is the first formal document presented to your 
potential customers, it is well worth each System Administrator’s time to ensure that this template is as 
professional and complete as possible. 
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Appendix B: Comprehensive Job Data (Excel Workbook) 

As pictured below, the Complete Job Data output is produced as a multi-tabbed Excel Workbook that 
contains all the job information entered into the Roofing Passport Jobs Tab on the first tab of the 
workbook, along with separate tabs for all of the Sheathing, Trim, Accessories, Labor and 
Freight required for a job. This output is standard and its contents cannot be edited or altered in any 
way. 

Below, this example shows the contents of the Sheathing Tab; the second tab of information included in 
the Excel Workbook.  
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Appendix C: Custom Job Data (PDF) 

The Custom Job Data PDF output is a highly-customizable one-page report that is available in both PDF 
and CSV formats. The PDF version shown below has been configured to include information from the 
Job Tab, along with materials information. 
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Appendix D: Custom Job Data (CSV) 

The Custom Job Data CSV output is a highly-customizable one-page report that is available in both PDF 
and CSV formats. The CSV version shown below, which has been opened in Microsoft Excel, has been 
configured to include information from the Job Tab, along with materials information. Note that the tab 
name on the worksheet is the same as the Job Name. Each separate section of materials is separate by a 
header row for the sake of clarity. 
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Appendix E: Roof Layout Drawing 

As pictured in the example below, the Roof Layout Drawing is a single page PDF file that provides an 
aerial view of ALL of the planes that comprise a roof. The version of this output shown here has been 
configured with the option to display the layout of all sheathing panels on the roof. 
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Appendix F: Sheathing Drawings 

The Sheathing Drawings output is a multi-page PDF report that provides a one-page drawing for each 
section of a roof, and the layout of sheathing panels on that section. The example provided below shows 
the panel layout for the second section of the roof shown in Appendix E.  
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Appendix G: Summary Sheet 

The Summary Sheet output provides basic roof dimension and job information, along with a 2D 
representation of the Roofing Passport 3D model. This output is commonly used as a cover sheet for the 
Roof Layout and Sheathing Drawing outputs used in the field. 

 


